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2 ProSail 

Dongle 

 

    

    

  

 The dongle is a small USB connector that plugs into a USB port on your computer. 

 For many ProSail machines, the dongle is required for the software to run. 

 However with the ProSail plotter mkIII or the ProSail digitiser, the dongle is an 
optional extra and is not supplied as standard.  With these machines the software will 
run so long as the data cable from the machines are plugged into the computer (the 
machine does not need to be turned on, just the data cable plugged in). 

  

Licence Agreement 

This is a legal agreement between you, the end user, and Armstrong-White 
Automation (NZ) Ltd.  This software is owned exclusively by Armstrong-White 
Automation (NZ) Ltd.  Armstrong-White Automation (NZ) Ltd grants you the right to 
use this software by way of this licence agreement.  It is important to note that if you 
loose the software CD, it will be replaced free of charge.  However, if you loose the 
dongle which protects this software, you have lost your entire software licence.  
Hence it is recommended that the dongle be insured for the full replacement cost of 
this software licence.  If however the dongle is only damaged, it will be replaced in 
exchange for the damaged dongle for no more than the material cost of the dongle. 

Disclaimer 

 Armstrong-White Automation (NZ) Ltd is not liable or responsible to the purchaser or 
user for loss or damage caused, or alleged to be caused, directly or indirectly by the 
software or hardware and its attendant documention, including (but not limited to) 
interruption of service, loss of business, or anticipatory profits. 
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Introduction 

The Nesting software is used for arranging (nesting) panels on the fabric.  Panels can be 
moved around, flipped and rotated.  There is also a semi-automatic compaction facility. 

If connected to a ProSail plotter or plotter/cutter it will drive the machine.  

DXF and HPGL files created by other CAD software such as CorelDraw and AutoCad etc 
can also be read (if that module is enabled). 

Nesting 

PanelMaker is a 2D design program where 2D panels (patterns) can be generated and 
modified.  There are 3 basic modes to PanelMaker : 

PanelMaker 

Additionally panels can be scaled up or down, reflected to allow for symmetry, and divided 
into smaller strips. 

Panel Mode 

Curve Mode 

Seam Mode 

Considers the global dimensions of the panel. 

Considers the local shape of individual curves in the panel. 

Considers the seam widths around the panel. 

This manual covers both the Nesting software and the PanelMaker software.  If you do not have 
the PanelMaker software please disregard the sections of this manual relating to Shaping, 
Scaling and Divide.  The Nesting software is included with the PanelMaker software or as an 
extra module for other ProSail software.  
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Units 

Selecting Units from the File menu : 

This dialogue determines the current units and decimal places displayed in all of the dialogues 
throughout the program. 

Although numbers will be displayed in these units they can be entered in any of the above 
units.  For example if you want to enter 1.5 feet into a dialogue, you can enter 1.5f or 1.5’ or 
1f6i or 1’6”.   Then after pressing the Enter key it will be converted to the current units you 
selected in the Units dialogue. e.g. 457.2mm 

If the current field is already displayed in the units that you want then when you enter a new 
number there is no need to add the units letters after the number.  Just type the number. 

Most dialogues have a % button that toggles between % and the current unit when you click in 
it. 

If for example mm is displayed in the % button then fields in the dialogue will be displayed in 
mm. 

If however %  is displayed in the % button then some fields will be displayed as a %.  Then if 
you enter a number into these fields it will be assumed to be a % unless you add the units 
letters to the end of the number. 

Some examples 

   entered   converted 

   4.2f    1280.2mm 

   1.4m    1400.0mm 

   4.2f - 7mm  1273.2mm 

   10i    254mm 

   100+10.7   110.7mm 
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Nesting 

The Nesting Window shows the panels on the fabric.  The icon near the top far right of the 
screen has two modes that govern the display of the Nesting Window : 

In this mode, the view of the panels is distorted horizontally so they can all be 
seen on the screen.   

Clicking on this icon will produce a dotted rectangle inside the Nesting Window.  
Using the mouse, position this rectangle at a location you wish to zoom in on.  If 
you want you can change the zoom scale by typing a number on the keyboard 
between 1 and 5.  Then click the mouse to zoom that rectangle.  The icon will 
then look like the following : 

In this mode, the view of the panels is drawn undistorted.  The horizontal and 
vertical scroll bars around the Nesting Window can be used to move around the 
nesting lay to see all the panels.   

Clicking on this icon will revert to the mode above so all the panels can be seen 
on the screen. 

(x,y) coordinates of the mouse cursor on the fabric.  x is the distance along the 
table.  y is the distance across the table.  (0,0) corresponds to the bottom left 
corner (Home). 

length  =  total length of fabric required. 

efficiency = (total panel area) / (length x fabric). 
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Nesting 

Flip the highlighted panel(s) vertically.  A flipped panel will have a rectangle drawn 
around its panel number to identify it is on the other side of the fabric.  This may be 
important if the fabric has a different texture on each side. 

Same as above except flipped horizontally.  

Permanently remove the highlighted panel(s).  

Duplicate the highlighted panel(s).  If Rename after Duplicate is ticked in the 
Preferences dialogue from the Nest menu, the duplicated panels will have a new 
number.  Otherwise they will have the same number. 

Highlight all panels of this colour.  To first display a colour in this icon, click the 
mouse in any panel.   This icon will then become the colour of that panel. 

Will display a dialogue where the panel(s) number can be entered.  If you don’t want 
the panel(s) to have a number, enter 0. 

Will remove the highlighted panels and save them to a specified file.  These files can 
later be read by selecting Open from the File menu. 

Click on a panel to highlight it.  To re-position a panel, click on it, and with the mouse button 
still down drag it to the required location.    To highlight several panels, either hold the Shift 
key down while clicking on them or click the mouse outside a panel and with the button still 
down drag a dotted rectangle around the desired panels.  

Another way to select a panel is to use the left or right arrow keys on the keyboard. 

 

The following icons apply to the highlighted panel(s) : 

Will display a message asking for the panel(s) text to be entered.  The Text will be 
plotted next to the panel number in a seam.  Note that if you enter too much text, it 
may appear off the edge of the panel. 
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Nesting 

Rotation 

Rotate the highlighted panel(s) clockwise by 90 degrees.  

Rotate the highlighted panel(s) clockwise by 180 degrees.  

Rotate the highlighted panel(s) clockwise by the specified angle (-ve for 
anticlockwise).  The following dialogue will appear :  

If Only for nesting is ticked, the panel is rotated on the Nesting Window but not in 
the Shaping Window of PanelMaker.  This is probably the most useful mode 
especially if a panel has been digitised and you don’t want its (x, y) coordinates 
rotated in the Shaping Window.  The rotate 90 and rotate 180 icons use this 
method.  

With this method the cumulative angle the panel has been rotated is remembered 
and is displayed in this dialogue.  Setting the angle to zero will rotate the panel 
back to its original orientation (the same orientation seen in the shaping window). 

If Only for nesting is not ticked, the panel is rotated in the Shaping Window as 
well as on the Nesting Window. 

Rotate the highlighted panel visually using the mouse. 

Click and release the mouse button on this icon to display a dotted line drawn 
between the centre of the panel and the mouse.  Move the mouse to a location on 
the screen (away from the panel), then click the mouse and (with the mouse button 
still down) drag the mouse to rotate the panel.  When the mouse button is released 
the panel will have been rotated.  The further from the panel you do the dragging, 
the more control you have. 

Rotates the highlighted panel(s) so the end points on 
the top curve becomes parallel with the fabric edge. 

Rotates the highlighted panel(s) so the end points on the bottom curve becomes 
parallel with the fabric edge. 
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Nesting 

Compacts all panels towards the left.  The vertical position of the panels is not 
changed.   

When you click in this icon, the software imagines all the panels are down the far right of the 
screen.  It then moves one panel at a time as far as possible to the left until it either hits the 
left of the screen or another panel.  The order in which it chooses the panels depends upon 
each panel’s left edge.  First it compacts the panel which has the left most left edge.  It moves 
this panel as far to the left as it can.  Then the next panel with the left most left edge is pushed 
as far to the left as possible.  This is repeated until all panels have been compacted.   

It is up to you to arrange the panels in the desired left to right order before clicking the 
compaction icon.  The compaction icon does not care if a panel overlaps other panels at the 
time you click the icon.  It only cares about the left edge of each panel. 

In the following example the panels are in the correct order before compacting. 

i.e. The left edge of panel 1 is to the left of the left edge of panel 2 : 

In the following example the panels are not in the correct order before compacting : 

Compaction  : method 1 
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Nesting 

The following example is a nesting lay of panels that have been compacted using the 
compaction icon.  However panel 6 has ended up in the wrong place. 

To solve this we need to move panel 6 until its left edge is to the right of the left edge of panel 
5 but before the left edge of panel 8.  (alternatively we could have moved panel 5 so it is in 
front of panel 6).  It doesn’t matter if panel 6 overlaps panel 8.  The nesting software is only 
interested in each panel’s left edge.   If you want to see a vertical line showing the left most 
edge of a panel when you drag it, click the right button on the mouse rather than the left 
button when you drag the panel.  Another useful feature of using the right button is that it 
makes sure the panel does not move vertically when you drag the mouse. 

Note : if you want a panel to be hard up against the edge of the fabric, make sure you move 
the mouse toward that edge.  The nesting software won’t allow you to push the panel off the 
fabric. 

Now click on the compaction icon : 

Reset Compaction: Often you might arrange panels to have the correct left edge before clicking 
the compaction icon.   However after the compaction the order may change.  This would 
indicate that if you click the compaction icon again it would then give a different result.    

To prevent this happening, the software remembers the order of the panels before its first 
compaction and uses that order each time you compact.   If however you later drag a panel it 
will recalculate that panels order based on its new left edge. 

However because the software is using this combination of original panel positions and new 
panel positions to determine the order in which panels are compacted it can start to behave 
unpredictably if panels are repeatedly shifted and then compacted.  To solve this problem, 
periodically select Reset Compact from the Nest menu. 
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Nesting 

Adding panels 

When you select Open from the File menu, the current panels on the Nesting Window 
are replaced with the panels from the file you are opening.  If instead you select Add 
from the File menu the panels in the file you are opening will be added to the end of 
the current panels on the Nesting Window.  These files will be highlighted and hence if 
you wish can easily be renamed with a letter next to their number by clicking on the T 
icon. 

Multiple files can be selected in the Open or Add dialogues by holding down the shift or 
Ctrl key on the keyboard while you click on the file.  This is a quick way to add several 
files to the nesting screen. 

Panels may also be compacted individually.  While holding down the Ctrl key on the 
keyboard, click in and drag the panel you wish to compact.  As usual a dotted outline of 
the panel is drawn as you drag.  However when the panel intersects another panel, the 
dotted outline attaches itself to that panel and does not move until you have moved 
away.  If you release the mouse, the panel will stay in that position hard up against the 
other panel.  Panels can be compacted in any direction with this method.  e.g. Useful for 
compacting rectangles vertically. 

Compaction  : method 2 

Panels may also be moved and compacted using the arrow keys on the keyboard.  Hold 
down the Ctrl key and click any of the four arrow keys to move a highlighted panel in 
that direction.   The panel will stop moving when it hits another panel. 

Compaction  : method 3 

Sometimes you want to save a copy of the nested panels to a different place (for 
example a memory stick to take to another computer).  You could use Save As. from 
the File menu but you will have to change the directory each time you do this between 
this new directory and the directory you normally save your files.  Also after saving, the 
software will think any changes have been saved and will not prompt you to save the 
file to its normal place later. 

To get around these problems use Copy to. from the File menu. 

Copy to. 
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Nesting 

Group/Ungroup 

Sometimes it is useful to link panels together so they act as though they are one panel on 
the Nesting window.  i.e. So they compact, flip, rotate etc as one panel.  For example, if 
the following two panels are grouped together they will not be separated after clicking the 
compaction icon (which otherwise they would have been) : 

To group panels together, highlight the desired panels and select Group from the Nest 
menu. 

To ungroup panels, click on any one of the panels in the group and select Ungroup from 
the Nest menu. 

To separate panels of different colours (fabric) into separate files : 

(i)   Click on one panel of a given colour to make the following icon that colour. 

 

(ii)  Then click on this icon to highlight all panels of this colour. 

 

(iii) Then click on this icon to save all those highlighted panels into a file.   

 

Enter a suitable file name.  If a message comes up telling you that the file already 
exists and asks you if you want to overwrite it, either say Yes and overwrite it or say 
No and then use a different name. 

 

Repeat the above process until there are only panels of one colour left on the Nesting 
Window.  They can then be nested and plotted.  To plot the panels we previously saved, 
select Open from the File menu and open one of those files, nest and plot.  Continue 
until all panels have been plotted. 

Separating Colours 
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Nesting 

Fabric Start 

Displays the following dialogue allowing you to define the starting edge of the fabric 
for fabric that has been cut at an angle.  After selecting OK to this dialogue, select 
the compaction icon to re-compact the panels to the new starting edge of the fabric. 

This icon will restore the fabric to a 
rectangular edge. 

New Panel 

Selecting New from the File menu to replace the current nesting panels with one of the 
following : 

Square (500mm, no seam)  is a simple 500mm x 500mm square panel.   This is 
quite useful as a starting point for creating a new 
panel. 

Circle (500mm dia.)  is a simple circle with a 500mm diameter. 

Square (100mm+10mm seam)  is a 100mm x 100mm square with a 10mm seam all 
the way around it.  This is often used with plotter/
cutters to test the distance between the pen and the 
knife.   See the Calibration chapter. 

Panel Origin 

Displays the following dialogue for specifying the lower left coordinates for an 
imaginary rectangle enclosing the panel. 
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Fabric Width 

Select Width from the Fabric menu : 

Largest panel : The width of the largest panel in the file.  Hence this is the 
minimum possible Fabric width that can be used.  Clicking in 
this button will place this value in the Fabric width. 

Nesting Width : The width of the nested panels.  A Fabric width less than this 
will necessarily shift the panels vertically to keep them on the 
fabric. 

Last Fabric : The last Fabric width the panels were saved on. 

Enter the fabric width the panels are to be nested on.  Alternatively, you can click the 
mouse on any of the following three buttons to use that width : 

Fabric 
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General 

Select the General tab from Plot Options from the Fabric menu : 

Comments The large edit field at the top of the window is useful for saving any 
comments regarding the particular fabric. 

Table size The maximum plottable length on the table.   Usually set at 100%. 

Gap between panels When using the compaction icon (see Nesting chapter) panels are 
pushed close together.   How close together is specified by Gap 
between panels.   A value of at least 10mm is recommended if using a 
cutter.  Anything smaller and than this and the resulting strip probably 
won’t be held down hard enough by the vacuum.  There are two methods 
of specifying this gap  : Horizontal or Envelope. 

 (i) If a Horizontal value is specified this value is the gap between the 
panels measured horizontally on the screen (i.e. parallel with the fabric).   

 (ii) If an Envelope value is specified (most common), the gap between 
the panels is measured at 90 degrees all the way around the panel.  The 
Envelope method is usually the best method since it produces an even 
gap all the way around the panels.  This is particularly important when 
using a plotter/cutter where you don't want the blade to come too close 
to another panel.  The Horizontal method will produce a much smaller 
gap between radial panels due to the angle of the panel sides to the 
horizontal.  Please note that to enforce either method you need to re-
compact the panels.  A Horizontal and Envelope value may be 
specified together if a combination is desired.  Otherwise, usually one is 
specified and the other is zero.  Note : If the Cntrl Compaction facility is 
used, only the Envelope method is considered. 

Fabric 
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Tell the nesting software that the fabric is smaller than it actually is.  For example you 
may be using fabric that is 914mm wide but you tell the nesting software that the fabric 
is really 894mm wide by specifying 894mm in the Fabric Width dialogue.  Hence we are 
wasting 10mm of fabric each side.  The fabric should be laid so the edge of the fabric 
averages the reference line marked on the table (some inside and some outside the line).  
We then need to tell the software to shift its plotting 10mm (50% of 20mm) in from that 
reference line.   This is done by setting Fabric edge shift in Plot Options to 10mm : 

The dotted lines relate to the boundary of the Nesting Window on the computer screen. 

Since the straightness and width of fabrics vary over their length, it may be necessary to take 
measures to allow for this and also to prevent the pen from catching on the edge of the fabric. 

Method 1  

Fabric 
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The Fabric edge shift method is of course the more accurate method and is recommended if 
you have a cutter since all the cutting is then done for you.  Despite the inaccuracies of the 
pen lift method it is still popular with Sailmakers especially for cross-cut sails.  Note that when 
using one method, the other value is usually zero.  e.g. Fabric edge shift of 10mm and pen 
lift of 0. 

The second method is to tell the nesting software the fabric width is the actual width of 
the fabric but also tell the plotter not to plot or cut when it gets to within say 10mm from 
the edge of the fabric.  This is done by specifying 914mm in the Fabric Width dialogue 
and specifying 10mm for pen lift and knife lift in the Plot Options dialogue : 

This method does not waste material and since the lines it does not draw are usually only 
seam lines it is not so important to plot them.  One exception to this rule is for panels 
that come from a cross-cut sail.   In this case the straight edge of each panel will only be 
approximated by the curved edge of the fabric. 

Method 2 

Fabric 
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Speed 

Select the Speed tab in Plot Options from the Fabric menu : 

move speed Speed the plotter will move when the pen and knife are up. 

pen speed Speed when the pen is down.  Pen speeds depend upon the fabric being 
used and the type of pen.  For example for Kevlar you will probably need 
to reduce the pen speed to prevent the pen from jumping as it goes 
over the fabric. 

knife speed  Speed when the knife is down. 

pen delay  Time in milliseconds the plotter waits for the pen to go up or down after 
giving it the signal to go up or down.  If for example the pen is taking too 
long to come down, the plotter may start moving before the pen has 
come down or may continue plotting for a short time before the pen has 
come up.  Hence to allow more time for the pen to go up or down, 
specify a larger pen delay. 

knife delay  Similar to pen delay but for the knife. 

acceleration  Defines how quickly the plotter gets up to speed.  3 is the highest 
acceleration, 1 is the lowest.  It is not recommended that both speed and 
acceleration are both set to their highest level.  Doing so risks the 
possibility of the plotter stalling. 

stop rate  Defines how quickly the ProSail plotter/cutter comes to a stop after 
pressing the stop button.  3 is the quickest stop. 

Fabric 
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Cusp Angle Largest angle that can be cut by the cutter without having to lift the head.  If 
an angle on a panel is greater than this, the knife will be lifted, rotated and 
lowered again.  If Cusp Angle is set too high, the cutter blade may break.   If 
it is set to low the cutting head may have to go up and down many times 
while cutting some curves. 

z-home Angle Cumulative angle of rotation that the cutter z-axis will rotate before it will 
automatically does a z-axis homing cycle.   That is to say after the cutter head 
has rotated by this amount it will check its position to make sure it is in the 
correct direction.  The smaller this angle the more often the cutter head does 
this check.  For a cutter mkIII, this can be kept very large.  For a cutter mkI 
or II it should typically be about 1000. 

cutter bounce  Used by the ProSail plotter/cutter to reduce how hard the cutter head comes 
down and hence increase the life of the plastic table surface.  If  cutter 
bounce is ticked and a non-zero value is entered, the cutter head will not 
come down so hard.   The more you increase the value, the softer the head 
will come down.   However, over a certain value, the head will come down 
hard and then go up again and then down again.   (The method used by 
cutter bounce is to send the signal for the head to go down, then after a 
delay equal to the cutter bounce value you have entered, a head up signal is 
given which slows the downward movement.  This is then following after 
another delay by the down signal again to continue the downward 
movement).   The optimal value will vary from machine to machine but 
around 30 seems to produce a soft movement for most machines. 

Fabric 

Cutter 

Select the Cutter tab in Plot Options from the Fabric menu : 
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Fabric Files 

The Fabric menu contains all the information regarding the fabric being used, namely the 
information in the Plot Options and Width dialogues.  Although this information can be 
saved in different files many people often just use the one default file called “Untitled.pst”.  

If you want to save different files with different fabric information in them e.g. different 
Speeds or Pen Lifts for different fabrics, use the Save As button in the Plot Options 
window to save the current fabric in a different file.  Then when you want to open a 
particular fabric select Open in the Plot Options window. 

warn before cutting Plotter/cutters first do plotting and then cutting.   If warn before 
cutting is ticked, a message will be displayed before cutting asking 
you if you want to start cutting. 

radius compensation  When cutting circles or part circles the pizza-wheel blade tends to be 
steered outward by the plastic table surface.  Ticking radius 
compensation will try to adjust for this by over steering the blade 
inwards slightly.  This is only an improvement, it does not solve the 
problem which of course is a physical limitation relating to the length 
of blade that is cutting into the plastic. 

cut under If using a plotter/cutter with a rotary blade, it will over cut the start 
and finish of lines because of the length of the blade in the plastic.   If 
needed this can be reduced by entering a value for start and end.   
e.g. If you find the cutter over cuts by 5mm at the start of a line and 
4mm at the end of a line, you might try entering 4mm for start and 
3mm for end. 

partial cutting This is very rarely used.  If plot is non-zero, the external cut lines of 
the panels will be cut in sections.  The length of each section will be 
equal to cut and the gap between each section will be equal to plot.  
This is useful for example if you want to roll up the panels after cutting 
and send them to another company. 

Fabric 
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Plotting 

Lay the fabric out and tape it to the table.  Masking tape is good for this.  Usually it is sufficient 
just to tape the cloth at the start of the table.  If using a cutter some people prefer to tape the 
entire side of the cloth to prevent air escape from the vacuum.  Use the reference line on the 
table nearest you to lay the fabric to.   

Cloth Bow : Because most fabric has a bow in it, it is recommended that you try to average 
the cloth edge on the line so at some places the cloth edge is inside the reference line and at 
others it is outside.   

Cloth Curl : If using a cutter with fabric that has a tendency to curl, it is recommended that 
the roll of fabric is turned upside down to prevent the edges from curling up and possibly 
catching on the cutter. 

Vacuum : If using a vacuum table it is important to cover the remainder of the table that is 
not being used.  Any holes that are left uncovered will dramatically reduce the power of the 
vacuum. 

 

After telling the plotter to plot, the plotter will plot the first table lay (frame).  If there is more 
than one frame the plotter will draw an L-Mark down the end of the table and a dialogue will 
appear on the screen asking you if you want to “continue next frame?”. 
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Plotting 

However, this effect is not so important if Plot complete panels only is ticked in 
Preferences from the Plot menu. 

Pull the fabric down the table until the L-Mark drawn on the fabric lines up with the start line 
on the table.  The corner of the L-Mark needs to be a specified distance up from the table 
reference line.  This distance (typically 10mm) is specified by L-Mark in the Hardware 
dialogue from Setup from the Plot menu.   A pin through the fabric to lineup with a preset L-
Mark hole on the table is a convenient way to do this. 

It is quite acceptable to push the plotter by hand if you find it is in the way.  Tape the cloth 
down again and when ready select Yes to the dialogue to continue the next frame.  The plotter 
will now plot the next frame. 

 

Although Edge-Shift and Pen Lift explained in the chapter titled “Fabric” can largely adjust for 
fabric bow, there still exists a problem when lining the fabric up for the next frame.  Namely a 
line drawn directly across the table down the end of the table will no longer be directly across 
the table when the fabric has been pulled to the front of the table.  This is because by pulling 
the fabric along the table and lining it up to the reference line on the table again, you in effect 
need to rotate the fabric slightly to keep it on the reference line. 
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Plotting 

Select Plot from the Plot menu : 

To plot all the panels for all frames (tables) make sure the All radio button is selected and click 
the Plot button. 

If you only want to plot some of the frames click the From radio button and enter the frame 
number for the first frame and the frame number for the last frame you want plotted.  They 
can be the same number.  The distances to the right give the position along the cloth that 
plotting will start and end.  You can compare these with the ruler drawn on the Nesting Screen.  
Then click the Plot button.   

 

Plot Selected Panels  This is an alternative to the Plot button.  It will only plot the panels 
that are selected (black) on the nesting screen. 

lines  This determines which type of panel lines are sent to your machine.   If cut 
is ticked, all lines that are defined as cut lines (for example all external 
lines in a panel are cut lines by default) will be sent to your machine.  This 
is unrelated to whether your machine is a plotter or a plotter/cutter.  For 
example if you have a plotter (not a cutter) and want the external panel 
lines to be plotted, you need to make sure cut is ticked.   

 Normally both plot and cut are ticked but sometimes you may want to redo 
just the plotting or just the cutting and so only one would be ticked. 

 Tick plot if you want panel plot lines (most internal panel lines are 
probably plot lines) to be sent to your machine.   

 Back is a special case and is described on the next page.  Normally it is not 
ticked. 

screen plot only If ticked, selecting Plot or Plot Selected Panels will only plot the panels 
on the screen.  It will not send the information to your machine.   This can 
serve as a useful check and is often used. 

use pen instead of knife If ticked, any lines that will normally be cut will instead but plotted.  
This is useful if for example there is a problem with the cutting mechanism 
on the cutter. 

Plot Options Displays the Plot Options window for changing speeds etc (see the Fabric 
chapter). 
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Plotting 

Stopping 

If the plotter has a stop button, press the stop button to quickly stop the plotter.   

If using a ProSail plotter or cutter you can also stop them by 
either clicking the mouse on the Stop button on the screen or 
pressing any key on the keyboard. 

When it has stopped, a message will be displayed on the screen asking you if you wish to 
continue plotting.  If you select Yes, the following window will appear : 

On rare occasions you may want to plot on both sides of the fabric.  To do this you 
must first tell PanelMaker which lines/text are on the back of a panel.  This is done in 
the shaping window by selecting a line/text and selecting plot back in the popup 
menu.  See chapter titled “Shaping : Panel Mode”. 

First we plot the back lines/text by turning the fabric over and rather than placing the fabric 
on the usual reference line on the table, place it on the reference line on the other side of 
the table (i.e. the line indicating the maximum plotting width).   Select Plot from the Plot 
menu and tick back.  It doesn’t matter if plot and cut are ticked.  Then click the Plot 
button.  The plotter will now plot only those lines marked as plot back.  When the plotter 
has finished, turn the fabric over and place against the normal reference line.  Select Plot 
from the Plot menu again.  You will notice that back is no longer ticked.  Make sure plot 
and cut are ticked and then click the Plot button to plot and cut out the panels. 

Plotting on both sides 

Clicking the <<back button will scroll back through the lines that have been plotted.  As 
you scroll, the desired line is highlighted on the nesting screen.  To see its location better 
click on the zoom button to see the following :   

Click Continue to continue plotting from the highlighted line.  You can also change speeds 
at this time if you wish. 
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Accuracy 

At the end of plotting a frame, the ProSail plotters and cutters test to see that they have 
come back to the exact position they are supposed to.  If they have not, a message will be 
displayed stating the accuracy giving figures for X, Y (and Z if applicable).  On rare 
occasions this may occur as a result of resonance that can not be avoided.   More commonly 
it will occur if the plotter is bumped or has caught the fabric or hit something on the table.  
If the inaccuracy keeps occurring then there is a problem and you should contact Armstrong
-White Automation (NZ) Ltd telling them exactly what numbers were displayed for each of 
X, Y and Z.   Also select Bug Report from the About menu.  This will create a file called 
“bugger.dat” that can be e-mailed to us. 

Move To 

Select Move To from the Plot menu.  This is an alternative to pushing the machine by 
hand.  There are four buttons identifying the corners of the table.  Clicking one of them will 
make the machine move to that corner.  Pressing the Esc key on the keyboard will cancel. 

Plotting 
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Select Preferences from the Plot menu : 

optimise plotting After plotting or cutting a curve, the plotter will move to the next 
nearest curve to plot or cut.   If not ticked the plotter may choose a 
curve that is a long way from where it currently is.   Hence 
optimise plotting is usually ticked.  

plot complete panels only see next page. 

current reduction Used only on the ProSail plotter MkII.   It reduces the current to the 
motors when they are moving at slow speed to reduced any 
resonance.   It is usually turned on. 

smooth curves see later. 

plot panels Individually If ticked, the plotter will totally plot and cut each panel before it 
moves on to the next panel.  This might cause problems with the 
pen catching if using a cutter and the cloth curls up after cutting.  If 
not ticked, a plotter/cutter would first plot all panels, then cut all 
panels. 

plot text If ticked, the plotter will mark any text that has been created using 
the text shaping facilities described in the chapter titled “Shaping : 
Panel Mode”. 

cut internal lines first If ticked, the plotter will cut any internal cut lines before it cuts the 
boundary of the panel. 

allow panels inside other panels If ticked, the software will not prevent you from plotting 
if one panel is totally inside another.  Normally you would want to 
be warned of this. 

save backup plot : ”BackupPlot.plt” If ticked, the software will automatically save a 
copy of the current nesting panels before plotting. It will be saved 
as BackupPlot.plt and can be opened as a normal nesting file later if 
for example something goes wrong while plotting. 
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Plot complete panels only  If ticked, the plotter will only plot a panel if it completely fits 
within the current table lay. 

Consider plotting the following panels that do not fit totally inside the table : 

If Plot complete panels only is not ticked, only panels 1 and 2 will be completely plotted with 
panels 3 and 4 only partially plotted.  An L-Mark will draw drawn at the end of the table which 
will be the start of the next table lay.  With this method, you will need to be very careful in 
lining up between table lays : 

If Plot complete panels only is ticked (most common method), only panels 1 and 2 will be 
plotted.  An L-Mark will be drawn to mark the start of the next table lay.  This method is more 
accurate since you do not need to be so careful lining up the lines between table lays.  However 
there may be more table lays required : 

In the special case of a panel being longer than the table size, the panel will automatically be 
split regardless of whether Plot complete panels only is ticked or not. 
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Panel numbering : 

The following 4 items determine how the panel numbers are plotted on the panels.  If 
you don’t want the numbers plotted turn off all 3 check boxes : 

number panels that have seams 

 If ticked, the plotter will draw panel numbers on all panels that have a seam and 
they will be drawn inside the seam. 

number all panels that don’t have seams 

 If ticked, the plotter will draw panel numbers on all panels that do not have a 
seam. 

move numbers in to prevent clipping at fabric edge  

 If ticked, numbers will be moved in from the edge of the panel if needed to 
prevent pen lift (see the “Plot Options” dialogue) from clipping them. 

size  

 The size in mm of the panel numbers. 

smooth curves Sometimes curves on panels may not be as smooth as they should be 
and are made up from a relatively small number of flats.   This is often 
the case when reading panels from other CAD programs using HPGL or 
DXF.   If smooth curves is ticked PanelMaker will smooth these curves 
out by adding extra points on the curve.  If you want the curve to be 
plotted as a set of flats, then turn smooth curves off. 

 

Draw : 

 internal lines If ticked, the plotter will plot (or cut) all internal lines inside the panel.   
Seam allowances are not considered internal lines. 

 seam lines  If ticked, the plotter will plot all seam allowances. 
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home off fabric  If ticked, the plotter will first move to the far side of the table 
width before homing.   The idea is to keep the pen off the fabric 
during homing down the length of the fabric.  This can be useful if 
the fabric has a tendency of curling up. 

start plotting from end of table Not commonly used, but if ticked, the plotter will first 
go to the end of the table and start plotting from that end first.   
For this to work you must also have optimise plotting ticked. 

park After plotting a table lay the plotter will come to a stop.  The 
position it stops at is specified by park.   X is the distance down 
the table from Home.  y is the distance across the table.  Often 
people specify a large y so the pen and knife is away from the 
fabric when the fabric is being pulled down between table lays. 

eliminate double cutting  If ticked, horizontal and vertical lines on adjacent panels that touch 
will be cut only once.  Useful if rectangles are nested close together.  
Note : This does not apply to angled lines or curves. 

check marks If ticked, the plotter will draw the specified number of evenly spaced 
check marks on all panel sides that are over the specified length.   These 
can be used as an aid in sticking panels together : 

Outward plotting If ticked, the plotter will always make sure the pen and knife are moving 
outward toward the edge of the fabric for lines that are within the 
specified distance from either edge of the fabric.  This prevents the edge 
of the fabric from possibly being pulled in by the pen or knife.  However 
it does take the plotter longer since it needs to do extra moves so its 
plotting/cutting can be in this direction. 

homing : 



30 ProSail 

Shaping : Panel Mode 

Select Shaping from the Edit menu or double click on a panel on the Nesting Window to 
display the Shaping window.  This window has three modes depending upon which of the 
following three icons is selected : 

Panel Mode 

Shows the panel sides and any internal curves for the current panel.   

The X and Y coordinate displayed corresponds to the “Current Point” which is encircled.  To 
select another point click the mouse near it.  These points are always in global coordinates.   

The curve which is green corresponds to the “Current Curve”.  To make a different curve the 
Current Curve click the mouse near it. 

Current Point 

X, Y : There are two ways to change the X or Y value of the Current Point : 

(i) Type in a new X or Y value using the keyboard.  Then hit either the Tab key or Enter 
key on the keyboard to recognise the change.  The Enter key will keep you in the 
same field.  The Tab key will take you to the next field.  Before entering a value into a 
field you need to make sure that field is highlighted.  If it isn’t hit the Tab key on the 
keyboard until it is highlighted or double click in the field. 

(ii) While holding the Ctrl key down on the keyboard click the mouse as close as possible 
to the Current Point and with the mouse button still down drag the point to the 
desired location. 

Current Curve 
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R If the Current Curve is an arc, a radius can be specified. 

L Displays the straight line length between the ends of the Current Curve.   If L is 
ticked, a new length can be entered here. 

move-All If ticked, changing X or Y will move the entire panel relative to the origin.     i.e. 
Rather than moving that point, the entire panel is moved so the Current Point is at 
that location.  In the case of the Current Point being on a internal curve (rather than 
the panel itself), only the internal shape the Current Point is part of will move. 

IMPORTANT : It is important to note that although the points can be placed at any location, 
they should not be changed to the extent that the panel folds over itself.  Even though it may 
look correct on the screen the panel will have been inverted and will cause problems in 
PanelMaker.  If you hold down the right arrow key on the keyboard, the Current Point should 
move around the panel in an anticlockwise direction. 

You can select multiple internal curves by dragging a rectangle around them or holding down 
the shift key on the keyboard and clicking in them (in a similar way to selecting multiple panels 
on the nesting screen).   

All operations : dragging, scaling, deleting, copying, rotating, duplicating, changing curve type 
or pen type will apply to all selected curves.  In the picture above, the orange and green curves 
are all selected.  Although there are several selected curves, there is still only one Current 
Curve and one Current Point which are green. 
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Adds a new curve.  After clicking Add, a horizontal and vertical line appears at the 
mouse location.  Also the following dialogue is displayed showing the default curve 

type to be added.  If this is not the type you want, click the mouse on the desired type before 
proceeding.  If its already the desired type, there is no need to click on it. 

Adds a cross.  Click the mouse at the desired position on the panel. 

Adds a circle.  Click the mouse at the desired position on the panel. 

Adds an internal curve.  Click and release the mouse at the desired start of the 
curve and then click and release again at the desired end of the curve. 

To add several internal curves that are connected (e.g. to make a window) : Hold 
down the Shift key on the keyboard before the first click of the mouse.  Then with 
the Shift key still down, click the mouse at the desired locations.  Before clicking 
the last point, release the Shift key. 

To produce a closed set of curves, the last point should be close to the first.  All 
these internal curves can later be shaped in Curve Mode. 

Adds another side to the panel or another side to an internal set of connected 
curves.  Click the mouse near an end point of a curve to add another curve at that 
point. 

Adds a radiused side to the panel.  Click the mouse near an end point of a curve to 
display the following dialogue asking for a radius and a choice of either an arc or a 
b-spline : 

If arc is selected, an arc of that radius will round off the corner.  If b-spline is 
selected, a b-spline of approximately that radius will round off the corner.  Unlike 
an arc a b-spline has the advantage of adjusting its shape so it remains tangential 
to the sides if their angle is later changed.  However a b-spline is not a true arc 
and hence not perfectly circular. 

Adds an internal curve with text on it.  This is the same as selecting a curve and 
then clicking the Text button (see next page). 
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Text desired text. 

Size height of text. 

h start distance along curve. 

v distance out from curve. 

other end if ticked, h is the end distance from the end of the curve (rather than start 
distance). 

rotate 180 rotate text by 180 degrees. 

other side text is on the other side of the curve. 

 

If text only is selected (most common) only the text will be plotted, the curve it is 
attached to will not be plotted even though it appears on the computer screen.   If Text & 
line is selected both the text and the curve will be plotted. 

 

The plotting of text can be turned on or off using the plot text check box in the 
preferences dialogue from the Plot menu. 

Displays the following dialogue for adding (or changing) text to the current curve.   
Hence to add text you must first have a curve.  However optionally these curves do 

not need to be plotted. 
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Displays the following dialogue where the desired length of the Current Curve is 
specified : 

The Current Point is moved to the required location so the straight line distance 
between each end of the Current Curve is equal to length.  The actual girth around 
the side (if the side has shape) can be seen in Curve Mode if required. 

If same direction is ticked, the Current Curve will remain parallel to its current 
direction : 

If same direction is not ticked, the angle of the Current Curve will change in order to 
preserve the length of the curve adjacent to the Current Point : 

retain length 
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This will create a new panel (initially a triangle). PanelMaker will then prompt you for the length 
of the sides.   After this it will optionally add more triangles to the shape.   Using this method 
you can define the shape of any panel. 

For example if you can measure the sides of a 4 sided panel and one diagonal measurement, 
the corners of the panel can be generated using this facility.  Any shape on the sides can later 
be added in Curve Mode. 

This facility can also be used to develop a 3D shape (such as a canopy on a boat) into a 2D flat 
panel by breaking it up into triangles and measuring their lengths.  

 

After selecting New Panel, enter the desired length of the bottom side of the triangle and 
click OK.  Next the same dialogue will appear for the vertical side of the triangle.  Enter that 
length and click OK.  Then the length for the diagonal will be requested.  After that length has 
been entered PanelMaker will split the diagonal up into two sides asking for the length of each 
in turn : 

Select New Panel from the Window menu : 
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With this dialogue you specify which side of the encircled corner is split into another two sides.  
This process will continue until you select Cancel to the above dialogue.  The resulting panel 
will look something like the following : 

Shaping : Panel Mode 

After the length of these two sides have been entered PanelMaker will display the following 
dialogue : 

Note : the diagonals used to develop the panel are drawn in blue (plot back mode).  This 
means they are visible but will not be drawn by the plotter.   

The Segment button (see next page) can then be used to smooth the top and bottom curves 
of the panel.   In summary you would click on the Segment button and then click max. 
Increase All curves.  Then for the top and bottom curves click on the Type button and make 
them spline curves to make the panel smooth : 

See also Develop Panel from the Window menu. 
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In PanelMaker, panels are made up of curves which in turn are made up of a set of 
Adjustment Points.  Segment changes the distribution of these Adjustment Points 

into different curves.  Clicking the Segment button displays the following dialogue : 

Each click of Increase curve will increase the Current Curve by taking 
the next Adjustment Point from the adjacent curve. 

Each click of Decrease curve will decrease the Current Curve by 
removing the current point from it. 

The Segment facility can be combined with the New Panel facility (on the previous page) 
to create a panel using triangular lengths.   For example the following panel could be 
generated using the New Panel facility where the top and bottom line segments are 
individual curves. 

Then use the Increase curve button in the Segment 
dialogue to combine the points on the top as one curve and 
then click the Spline curve button to smooth it.  The same 
can be done for the bottom.    

However a quicker way would be to click the max. Increase All curves button. 

Automate the Increase curve method for all curves based on a 
specified max. smooth angle. 
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Fully reduces the Current Curve into flat segments.  This is the 
same as repetitively clicking the Decrease curve button. 

Fully reduces all curves to individual segments. 

This is not commonly used but can be useful in special situations.  If 
a curve is simply a straight line (i.e. a point at each end) as it would 
be if max. Decrease curve was used, B-Spline curve will make 
the curve into a b-spline curve with an angle (tangent) at its ends.  
PanelMaker will choose the angle of these tangents based on the 
length of each adjacent side.  The greater the length of the adjacent 
side, the closer the tangent will be to parallel with that adjacent side.  
If all three sides are the same length the tangents will equally bisect 
the corners. 

Again not commonly used.  Makes all the straight line curves in the 
panel into b-splines as above.  This is useful for smoothing a panel.  
Curves other than straight line curves will remain the same. 

Turns the current curve into a spline curve.   This is the same as 
clicking on the Type button and clicking on the spline icon. 

With max. Increase All curves PanelMaker looks at the angle between all adjacent lines.  
If this angle is less than max. smooth angle it will assume these two lines are part of a 
curve.  Otherwise it will assume they are separate lines forming a corner.  The trick is to 
specify a max. smooth angle that is large enough to combine the segments you want 
combined but small enough to not include the corners. 
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The angle of a corner can be specified.  Highlight the desired point (you also need to 
consider which side of the point you want highlighted as this will be the side that is 

rotated).  Then click on the Angle button to display the following : 

The angle specified is the internal corner angle of the selected point.   It includes 
the amount of shaping in the adjacent sides.   However if you tick ignore shape 
in sides it will not include this shape in the angle. 

If selected point is ticked, the other end of the highlighted curve will move to 
achieve the specified corner angle at the selected point.   

If other end is ticked the selected point itself is moved to achieve the specified 
corner angle at the selected point. 

(i) If you have selected an internal curve and the selected point is not joined to 
any other curves, the angle specified is the angle to the horizontal. 

(ii) If rather than specifying a corner angle, you want to rotate the selected curves 
by a specified amount (or the entire panel),  select Rotate from the Window 
menu. 

Variations : 
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free Current Curve will have no angle constraints at the Current Point (most 
common). 

tangent Current Curve will be tangential (parallel) to its adjacent curve at the 
Current Point. 

right angle Current Curve will be at right angles to its adjacent curve at the Current 
Point. 

Slope continuity 

Line segments and B-splines with one or more Adjustment Point can be 
made to be tangential to or at right-angles to its adjacent curve at the 
Current Point.  Even if the panel shape is changed the curve will adjust to 
retain these angles. 

plot Current Curve will be plotted. 

cut Current Curve will be cut rather than plotted. 

plot back Current Curve will be marked as being on the opposite side of the panel.  It 
will normally not be plotted or cut by selecting Plot from the Plot menu.  To 
plot or cut it you need to tick the back check box in the Plot dialogue.  See 
the chapter titled “Plotting” for more detail. 

 Another use for plot back is if you want to keep a record of a curve but don’t 
want it plotted.   You can later change its style to plot or cut if desired. 

Plotting style 

Defines the plotting style of the Current Curve 

Visually scales the curves for clarity of viewing.  Most useful in Curve Mode for 
shallow curves.  Note that this is only a visual effect and does not change the 
shape of the panel. 

Loops through all the panels.  The current panel’s number is displayed above it.  
Other ways to loop through the panels is with the mouse wheel or using the Page 
Up or Page Down keys on the keyboard. 

To enter the Shaping window at a desired panel double click on that panel in the 
Nesting Window or highlight the panel then select Shaping from the Window 
menu. 

See “Shaping : Curve Mode” chapter. 



41 ProSail 

Shaping : Panel Mode 

New panel 

 See New Panel earlier in this chapter. 

Develop panel 

 Useful if rather than starting with an initial triangular panel you want to add to an 
existing panel (e.g. maybe you left New Panel before finishing and now want to 
continue). 

 The current curve will be split into two curves.   The process will then continue as 
described with New Panel. 

Blue panel 

 Turns a normal panel into a blue panel.  A normal panel has a boundary around it 
and usually some internal curves.  A blue panel on the other hand does not require 
an external boundary.  DXF or HPGL panels are read as blue panels if they do not 
have an external boundary.  Sometimes blue panels are useful when you don’t want 
the boundary of the panel to be cut. 

Reflect 

 To reflect a panel, first click the mouse on a horizontal or vertical line (either 
internal or external) on the panel, then select Reflect. 

Scale 

 Uniformly scales the selected curves by a specified amount. 

Rotate 

 Rotates the selected curves by a specified amount.  If the Current Point is on the 
boundary, the entire panel including internal curves are rotated. 

 

Window menu 
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Zoom Ctrl Z 

 Zoom in on a particular part of a panel.  A horizontal and vertical line will be 
displayed at the mouse location.  Move the mouse to the area you want to zoom in 
on.  Click and hold down the left mouse button and drag the resulting selection box 
to encompass the area you want zoomed.  When the mouse button is released, the 
selection box will be zoomed to fill the entire window.   

 A quicker way to zoom without having to go to the Window menu is to hold down 
the Ctrl key on the keyboard and with it still held down press and release the Z key 
on the keyboard.   Then release the Ctrl key.   

 Note: there are two modes when dragging the selection box.  Either the click of the 
mouse will correspond to one corner of the selection box or the click will correspond 
to the centre of the selection box.  To swap between these two modes, press and 
release the Ctrl key while the selection box is visible. 

Unzoom Ctrl U 

 Restore the view to normal scale.  A quicker way to unzoom is to click on the scale 
scroll bar.  

Units 

 See Units page at the beginning of this manual.  

Shaping : Panel Mode 
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Global Axes Determines the direction of the global Y-axis : up or down. 

show Net Draw the Net for B-Spline curves in Panel Mode.  This Net 
may be dragged if the scale scroll bar is at the bottom.  i.e. 
a scale of 1. 

snap to points Makes dragging and adding of points in Panel Mode snap to 
horizontal and/or vertical positions of other points when the 
vertical and/or horizontal position of the mouse is similar.  
This is very useful for lining up curve end points, crosses, 
circles and for producing horizontal and vertical lines. 

selected line color  This is the colour of the “current curve”. 

group line color This is the colour of any addition curves that might be 
selected. 

use the last plot/cut/back style when adding  If ticked, any curves that are 
added will be of the same style as the last added curve. 

Ctrl key required for Adjustment  If ticked, you need to hold down the Ctrl key 
on the keyboard in order to drag the end of a curve with the 
mouse. 

preferences 

Shaping : Panel Mode 
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Edit menu 

Undo 

 Undoes the last change you made in shaping.  You can keep undoing repeatedly 
until all the changes you have made have been undone. 

Redo 

 Cancels the last undo.  You can keep redoing repeatedly until all the undoes have 
been cancelled. 

Add Ctrl A 

 See Add earlier in this chapter.  This is the same as clicking the Add button. 

Cut Ctrl X 

 Removes all of the selected curves.  This is the same as clicking the Cut button. 

Copy Ctrl C 

 Copies to memory all of the selected curves so they can later be pasted. 

Paste Ctrl V 

 Pastes any previously copied curves.  These curves can also be pasted to other 
panels if desired. 

Duplicate Ctrl D 

 If duplicating internal curves, Duplicate is similar to using Copy and Paste except 
it remembers the distance between where the original curves are and where you 
have moved the duplicate curves to.  The next time you use Duplicate, it will use 
this same distance.  This is useful for creating a line of evenly spaced objects.  First 
duplicate one, move it the desired distance from the original and then repeatedly 
duplicate. 

 If duplicating the side of a panel, Duplicate will simply add another side with the 
same shape. 

Cut single  Ctrl S 

 Same as cut except it only removes the Current Curve regardless of how many 
other curves are also selected. 

A popup Edit 
menu is also 
available by 
right clicking in 
the window. 



45 ProSail 

Shaping : Panel Mode 

Grouping menu 

Group 

 If several curves are selected, Group will turn them into one entity.   After 
grouping, clicking in any one of these curves will select all of them.  

Ungroup 

 Ungroups all selected curves so they can be selected individually.   It also upgroups 
any selected curves that are joined.  In the above picture the 4 sided shape would 
turn into individual curves that you can move apart.  If you want to keep connected 
curves grouped together you could select all curves in the panel and click on Group 
only if connected. 

Group only if connected 

 Of the selected curves it will group together only those curves that join to each 
other. 

Print menu 

 Prints the current panel picture. 
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Curve Mode 

Displays the Current Curve in local co-ordinates.  You can enter Curve Mode either by clicking 
on this icon or double clicking near the dotted line connecting the ends of a curve in Panel 
Mode. 

The relationship between Panel Mode and Curve Mode is summarised by the following 
examples.  The left end of the curve in Panel Mode always corresponds to the left of the curve 
in Curve Mode : 
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To select an Adjustment Point and display its X and Y position, click anywhere near the 
Adjustment Point (preferably significantly above it so as not to accidentally move it).  There are 
three ways to change an Adjustment Point’s X or Y : 

(i)   Click on an Adjustment Point and with the mouse button still down, drag it to the 
desired location.  The point will only move vertically.  To move it horizontally as 
well, hold the Ctrl key down on the keyboard while dragging. 

(ii)  Click on the red arrow and drag it horizontally to change X. 

(iii) Type the desired X or Y value using the keyboard.  Then hit the Enter or Tab key on 
the keyboard. 

There are 3 different coordinate systems. 

global : X and Y are relative to the origin in Panel Mode. 

local : X and Y are in local coordinates across the curve (most common). 

triangular : Similar to local coordinates except LHS and RHS is used rather than 
X and Y. 

move-All If ticked, changing the Y value for one Adjustment Point will uniformly 
change the values for all the Adjustment Points.  Useful for scaling curves up 
or down. 
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Adds a new Adjustment Point to the curve.  After clicking Add, a vertical line 
appears at the mouse location.  Move it until it is approximately where you want 
and click the mouse button.  If the exact required X value is known, it can then be 
entered through the keyboard. 

Removes the highlighted Adjustment Point. 

Toggles the X and Y display between % and absolute units (e.g. mm).  Both X and 
Y are expressed as a % of the straight line length between the ends of the curve. 

This is the length measured around the curve.  Hence this is greater than the 
straight line length between the ends of the curve. 

girth = 

The vertical position of the curve in the window can be moved with the mouse if desired.   
This is often done if the curve is hollow and hence falls below the viewing rectangle.  To move 
the curve, click the mouse very close to the horizontal line drawn between the ends of the 
curve and with the mouse button still down, drag the curve up or down.  When in the 
required position release the mouse button.  Note that this does not change the shape of the 
curve, it is only a visual tool. 

If ticked, changing Y (or dragging an adjustment point) will scale the entire curve.   
Note : the Y value initially needs to be non-zero for this to work. 
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The Type dialogue determines the nature of each curve : 

Click on one of the following icons to change the curve type : 

Curve is made up of line segments.  i.e. Made up from a set of connected straight 
lines : 

Curve is a Spline.  This is an efficient way to produce a smooth curve.  A special 
case applies if there is only one Adjustment Point in which case the curve is an 
arc.  In Panel Mode this arc will have a radius field that can be changed. 

Curve is a B-Spline.  B-Splines produce nice looking curves.  However unlike 
Splines, the Adjustment Points don’t lie on the curve.  The straight lines 
connecting the Adjustment Points are called the B-Spline Net.  One useful feature 
of B-Splines is that the ends of the Net are tangential to the ends of the curve.  
Hence the Slope Continuity set to Tangent in Panel Mode can be used on a B-
Spline curve to force the curve to blend smoothly into its adjacent curve. 

Number of points Number of Adjustment Points required. 

If only the number of points is changed the points will automatically be evenly spaced in 
X.  If however the  curve type is changed the following dialogue will be displayed asking if 
you want the points to be evenly spaced : 
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Shaping : Seam Mode 

Seam Mode 

Displays the seams on the sides of the panel.   

out is the seam added to the outside of the panel size defined in Panel Mode.   

in is an additional line drawn inside the panel size.  in is useful for example if you want to 
plot a line inside the panel that the outer seam edge will fold to.  in can also be -ve if 
desired.  In order to change a value of in, it must be ticked.  If you are not likely to want to 
change a value of in, it is recommended you remove the tick to prevent them from 
accidentally changing. 

To highlight another side, click the mouse near it or use the left or right arrow keys on the 
keyboard. 

Note : The ends of the seams are only drawn in Seam Mode as 90 degree corners.  This is 
just a display method to allow the scale scroll bar to work in a predictable way.  The above 
panel will actually be formed as follows : 
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Shaping : Seam Mode 

Make all seams equal to current seam  gives all the sides of the panel the same seam as 
the currently highlighted side. 

 

Increase panel by outer seam  removes the outer seams around the panel but will 
increase the size of the panel to take its place.   
Hence the overall panel will stay the same size but 
will have no outer seam line. 

 

Reduce panel by inner seam  removes any inner seams around the panel and 
decreases the panel size by that amount. 

Displays the following dialogue :  
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Sometimes it is necessary to fold a seam on the edge of a panel (a turnover seam).  
However if the seam width is large and/or the panel has a large amount of shape on 

it (as is often the case with the outside edge of an awning) it is difficult to fold the material 
without it creasing.  A solution is to cut small nicks periodically along the seam. 

nick size :  Width of nicks.  This can be entered as a percentage of the seam width if 
desired. 

angle per nick : This determines the number of nicks on that curve.   If the curve has a 
cumulative angle change along its length of 20 degrees and angle per nick 
is 5 degrees, then 4 nicks will be placed on that curve. 

The scroll bar lets you adjust how the nicks are distributed along the curve.  With the scroll bar 
at the bottom they will be evenly spaced along the curve.  With the scroll bar at the top the 
nicks will be spaced based on angle so they will bunch up in tighter regions of the curve. 

Regardless of where the scroll bar is the total number of nicks will be determined solely by 
angle per nick. 

Once you have defined nicks for one curve, you can easily copy this to other curves in this 
panel or to other curves on other panels by using copy and paste (right click the mouse to 
display the popup menu). 

Shaping : Seam Mode 
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Scaling 

Highlight the panels you want to scale on the nesting window and select Scale from the Edit 
menu to display the following dialogue : 

Panels may be scaled horizontally (horizontal) or vertically (vertical) or evenly in both 
directions (both). 

The Scale is calculated from the top number divided by the bottom number.  The reason for 
doing it this way is so you can compare a current dimension on a panel with the desired. 

Example 1) : If the width of the panel is currently 500.0mm (as per the dialogue shown above) 
and we want the panel to be scaled evenly until the panel width is 750mm : Click the width= 
500mm button to place this value in the bottom number.   Then type 750mm in the top 
number.   PanelMaker will divide the two numbers to produce a scale of 150%.  Click Ok to 
scale the panel by this amount. 

Example 2) : To make a panel 20 larger, type 120 in the top number leaving 100 in the bottom 
number giving a scale of 120%. 

Note : If scaling horizontally or vertically, circles will not become ellipses but will remain circles.  
Also all curves will retain exactly their same % shape.  This means that even if a panel is scaled 
horizontally it will change size vertically if there is a curve on the top or bottom of it  (as shown 
below) 
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Divide 

Highlight the panel(s) you want to divide on the nesting window and select Divide from 
the Edit menu.   If the width tab is selected the panel will be divided starting from the 
bottom up based on width and seam : 

Note that panel 1c is not to the full width.   If you want panel 1c to be to the full width 
and panel 1a to be smaller, rotate the panel by 180 degrees before dividing.  If you 
want the seams to run at a different angle, rotate the panel by that angle before 
dividing. 

If you desire the seam to be placed on the other side of the panels, tick Move seam to 
other side. 

If rename panels is ticked, the divided panels will have an extra letter placed after 
their name.  Otherwise they will just be the same name as the original panel. 

Divide can be used to slice a large shape such as a large flat cover into panels of a 
specified fabric width.   Use PanelMaker to first generate the full size of the cover (the 
triangular co-ordinate system in Curve Mode can be useful for this) and then use Divide 
to create the panels.   After Dividing, it is sometimes more efficient to rotate every 2nd 
panel by 180 degrees before compacting them. 

Dividing a panel(s) based on a width 

Version 2 should 
normally be selected 
since it is the most 
advanced version.  
However if there are 
some problems try 
version 1. 
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If a small amount of shape is required on each of the seams, this will be done 
automatically if Shape divide seams is ticked : 

A spline curve with the same shape as an arc will be placed on the top and bottom of 
each panel with a % Depth as specified.  Hence the longer the panel side, the 
greater the actual depth of the curve.  The spline will have the Number of points 
specified which can be used for adjusting the shape in PanelMaker later.  Note that 
this will increase the width of the panel and hence the width specified will need to be 
smaller than the fabric width to allow for this. 

Divide 
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A seam is added to one side of each cut line.  The side it is added to depends upon the 
direction used to create the cut line.   If the cut line was created by dragging from left 
to right for example, the seam will be placed below the line.  However if Move seam 
to other side is ticked, the seam will be on the other side. 

If rename panels is ticked, the divided panels will have an extra letter placed after 
their name.  Otherwise they will just be the same name as the original panel. 

 

If desired a cut line can also be a shaped curve.   The only requirement is that the 
ends of the curves end outside the panel. 

Dividing a panel(s) based on defined curves 

First you need to create lines that you want the panel divided along.  Go to the shaping 
window of PanelMaker and add internal lines in the usual way by using the Add button.    
These lines must completely cut the panel.  Namely both ends of the lines must be 
outside the panel.  Then mark these lines as "cut" lines.  

As many lines can be created as you wish.  Leave the shaping window, highlight the 
panel(s) and select Divide from the Edit menu.   If the cut lines tab is selected, the 
panel(s) will be divided along these lines. 

Divide 

Version 2 should 
normally be selected 
since it is the most 
advanced version.  
However if there are 
some problems try 
version 1. 
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Hardware 

Select Hardware from Setup from the Plot menu : 

This dialogue defines the hardware of the plotter.  Some of the values will probably never need 
changing directly.  Some of the values like x-scale etc will be automatically changed during the 
calibration process. 

Machine This is set for your plotter and can not be changed. 

 

Port This is the communication port on your computer that the plotter is connected to.  
To find out what com ports your computer has, go to the Windows Device Manager.  
Depending upon your version of windows you can get to the Device Manager by 
going to the windows “Start” button, select  “Control panel” and then double click on 
“System”.   Then click on “Hardware” and “Device Manager”.  Then double click on 
“Ports (COM & LPT)”. 

 

Pen Because different pen sizes will have a different distance between their centre and 
the cutting blade, it is useful to store these different values for different pens.  Then 
when you go to plot you can select the pen you will be using in the plotter. 

 The Pen section stores this information.  For each pen there is an offset X and an 
offset Y.  Offset X is the distance between the centre of the pen and the cutting 
blade in the direction of the table.  Offset Y is difference between the pen and 
blade in the direction across the table (this will be close to zero).   

 Click Add to display a dialogue where you can add another pen with its own name 
and x, y offsets.   You can store up to 20 pens.   

 When using Shift Cutter in the calibration dialogue from Setup from the Plot 
menu, the software will automatically adjust these offsets for the pen you select. 

 To accurately test if Offset X and Offset Y are correct for a given pen, plot a 
square with a seam (New from the File menu).  This should have a seam width 
of 10mm all the way around it.  If not you can adjust Offset X and Offset Y. 
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Hardware 

L-Mark Distance from the edge of the plotted boundary that the L-Mark is drawn. 

 

Knife up sensor If ticked, the software will look at the sensor on the cutting head to get 
confirmation that the head is up or down.   In this way it is able to warn you if the 
head is not behaving as it should.   If there is a fault with the sensor this can be 
temporarily turned off. 

 

Vacuum, Auto-Frame  Not used. 

 

-ve X If ticked, will place Home (0,0) at the opposite end of the table.  Hence the cloth is 
loaded from the other end of the table.  However the plotting on the table is 
necessarily reversed from the display on the screen.  For that reason it is not 
recommended. 

 

-ve Home If ticked, will place Home (0,0) at the opposite side of the table.  Hence the cloth is 
loaded from the other side of the table.  However the plotting on the table is 
necessarily reversed from the display on the screen.  For that reason it is not 
recommended. 

 

x-scale,  

y-scale These are the number of instructions the software needs to give the plotter for it to 
move 1mm.  These numbers are automatically calculated when the plotter is 
calibrated using XY Scale in the calibration dialogue from Setup from the Plot 
menu.  It is unlikely you would ever change these directly.  Change with care! 

 

Skew Tells the software how to adjust for the angle of the plotting arm not being exactly 
90 degrees to the table.  This number is automatically calculated by using Skew in 
the calibration dialogue from Setup from the Plot menu.  It is unlikely you would 
ever change this directly.  Change with care! 

 

X-diff Adjusts for any difference in length between the belt on one side of the table and 
the other side for a plotter/cutter.  This number is automatically calculated after 
using XY Scale in the calibration dialogue from Setup from the Plot menu.  It is 
unlikely you would ever change this directly.  Change with care! 

 

Z-offset This is the value you entered while using Zero Cutter in the calibration dialogue 
from Setup from the Plot menu. 

 

Centre-offset This was automatically calculated after using Shift Cutter in the calibration 
dialogue from Setup from the Plot menu.  It is unlikely you would ever change this 
directly.  Change with care! 
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Calibration 

Select Calibrate from Setup from the Plot menu.  This calibrates the ProSail plotters and 
cutters to allow for stretch in the belts and table movement.   It needs to be done when the 
machine is first installed and periodically afterwards (every few months is recommended). 

XY scale This calibrates for tension in the X and Y belts.  Place a pen in the plotter and 
click XY scale and then click OK.  The plotter will draw some marks on the 
table.   After drawing them you will need to measure between them with a 
tape measure and enter those 
measured values into the resulting 
dialogue.  The software will then 
calculate new x-scale and y-scale 
values in the Hardware dialogue to 
adjust for belt tension.  It will then 
return you to the Calibration dialogue.  
If you run XY scale again (the marks 
will probably have moved slightly) and measure between the marks they 
should now exactly equal your Table Size in the Plot Options dialogue from 
the Fabric menu. 

Skew This adjusts for the arm of the plotter not being at exactly 90 degrees to the 
table.  The cutter could also become out of skew if one of the cogs over the 
rails slips.  Click skew and then click OK.  The plotter will draw some marks 
on the table.   After drawing them you will need to measure between them 
with a tape measure and enter those measured values into the resulting 
dialogue.  In particular you need to measure the diagonal measurement very 
accurately.  The software will then calculate a new skew value in the 
Hardware dialogue to adjust for the angle of the arm.  It will then return you 
to the Calibration dialogue. 

Zero cutter This adjusts the homing angle of the cutter blade on the ProSail plotter/
cutters.  This is very important and must be done as accurately as possible.  A 
small inaccuracy in this angle can result in blades blunting very quickly on 
fabrics like Kevlar.  The operation of zero cutter depends upon the version of 
cutter that you have.   See next page. 
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Calibration 

Zero Cutter for cutters MkI & MkII do the following : 

 Click on Zero Cutter (stage I) and then click OK.   A dialogue will be displayed asking 
for a number.  After entering a number and clicking Ok, the cutter head will rotate to the 
corresponding number.  Continue this process with different numbers until the blade is 
pointing directly down the table.  The blade will rotate approximately 0.3 degrees for each 
unit of number entered.  When happy, click the Esc button to permanently store this 
number.  To judge if the blade is straight down the table, it is recommended you take the 
blade off the cutter shaft, place a straight edge to the shaft face and reference this to a 
straight line drawn down the table. 

 To test (and improve) the accuracy of the blade direction select Zero Cutter (Stage II) 
and OK.  First it will ask you for the position down the table and then position across the 
table you want to conduct the test.  It will then do a  plot and cut line.  A window will then 
appear asking you how you want the angle of the cut line adjusted.  It will continue to do 
test plot and cut lines (each time moved across the table by 5mm) until you are happy 
the two lines are parallel.   

 

Zero Cutter for the cutter MkIII do the following : 

 Draw a line (at least 300mm long) near the front of the table at 90 degrees to the 
channel rail (see picture below).   Using a set-square against the channel rail is the best 
way to draw this line. Mount the supplied 160mm aluminium angle to the blade holder as 
shown below. Do not over tighten.  Note that the inner washer has its large flat side 
against the angle for rigidity.   Move the head of the cutter so it is over the top of the 90 
degree line you drew on the table.  Turn the cutter shaft so the aluminium angle is 
roughly parallel with this line. 

 

 

 

 

 

 

 

 Click on Zero Cutter and then click OK.   Click ok to the message dialogue.  The next 
dialogue asks for a Z-home offset.  Make sure “accoss table” is selected.  After clicking 
ok, the blade will rotate and the head will come down.  Then compare the blade angle 
with the line on the table (you can move the cutter if you wish to help visibility).  The 
current angle of the face can be changed by entering a new number in this dialogue and 
clicking ok.  The blade angle will rotate clockwise by approximately 0.1 degrees for each 
unit entered.  E.g. If the face is 10 degrees from the line, add or subtract 100 to the 
current number and click ok.   Repeatedly change this number and click ok until the 
angle is parallel with the line on the table.  When happy with the direction, click the Esc 
button.  The software will now return you to the Calibration dialogue.  Remove the 
aluminium angle and the large washers (the inner washer orientation has changed).  Also 
note the spring washer which is very important. 
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Shift Cutter To adjust for the distance between the pen and the blade, select Shift 
Cutter and Ok.  It will ask you for the position down the table and then 
position across the table you want to 
conduct the test.  It will then plot a cross 
and cut 3 short lines and ask you to 
measure the distance between the plot and 
cut lines.  You need to be very accurate with 
these measurements (e.g. 9.7mm is better 
than 10mm).  After doing this the software 
will return you to the Calibration dialogue.  
For Shift cutter to be accurate there must 
be no mechanical slop in the cutter.   If there is it will be necessary to plot a 
small square with a seam as described at the bottom of this page.  

Cutter Bounce  This reduces how hard the cutter head comes down and hence increase the 
life of the plastic table surface.  It is explained in the Fabric chapter.  The 
calibration dialogue can be used to test different values for Cutter Bounce.   
To do this, click on Cutter Bounce and then click OK. 

Draw L-Mark This draws the position of the L-Mark at the front of the table.  This is the 
position on the table the L-Mark on the fabric should be dragged to between 
frames.  The value used for L-Mark is entered in the Hardware dialogue.  

Draw Boundary This draws the maximum plotting size of the plotter on the table.  In 
particular the table reference line the fabric needs to be laid against. 

Calibration 

As a final check after calibrating it is often useful to plot a small square with a seam.  To do 
this, select New from the File menu and select Square (100mm + 10mm seam).  Position 
the resulting panel in a position on the nesting window to do a trial cut.  Load some paper on 
the table in this position and tape it down.   

Select Plot from the Plot menu.   

Make sure that both plot and cut are ticked.   

Make sure that both use pen instead of knife and screen plot only are not ticked.  

Click the Plot button to start plotting. 

The machine should plot the inner part of the square and then cut the outer part of the square.  
There should be an even seam width of 10mm around this panel.   

If the seam width varies along one side it would indicate that Zero Cutter is not correct. 

If the seam width is wider on one side of the square compared to the adjacent side, adjust the 
offset X and offset Y values in the Hardware dialogue (select Hardware from Setup from 
the Plot menu) by a small amount until the seam width is the same all around the panel. 

If the seam width is too large or too small on all sides it would indicate that Shift cutter is not 
correct. 
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Select PVC Joins from Setup from the Plot menu.  This is used to prevent the cutter blade on 
the ProSail plotter/cutter from catching on the joins in the PVC table top. 

PVC Joins 

If Enable knife lifting at all joins is ticked the cutter will lift the blade if it is about to cut a 
line (or part of a curve) which is within Tolerance from one of the PVC joins and at an angle 
less than Angle Limit to that join. 

Use Add to add more joins.   

Use Delete to delete the selected join.   

Click on a join to select it.   

If the selected join is across the table, Position is measured from the front of the table 
boundary (which was drawn on the table by Draw Boundary). 

To make a horizontal join, remove the tick from Across Table.  Position is then measured up 
from the lower boundary line (cloth load line which was drawn on the table by Draw 
Boundary). 

To change the Angle limit for all the joins click on the Angle Limit button. 
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Test Hardware 

Select Test Hardware from Setup from the Plot menu.  This is used to help diagnose 
problems with the ProSail plotters or plotter/cutters.  This dialogue tests the signals going to 
the plotter from the computer : 

Clicking any of these buttons should perform the associated operation.  First make 
sure that the arm and head are sufficiently away from any limit switches.  i.e. push 
the machine back from the front of the table and the head to the middle of the arm.  
Pay particular attention to the direction of travel to make sure it is correct when 
doing these tests. 

Motors Hold is useful for testing if there is any mechanical slop in the machine.   
After clicking Motors Hold, all 3 motors will hold hard (2 motors for a plotter).   If 
you then physically try pushing the arm or head, there should only be a small 
movement that bounces back when you stop pushing.  If there is too much or it feels 
like something is loose, check all the belts and pulleys to see if there is some 
mechanical slop.  Of course if you press too hard, it will overcome the power of the 
motors and the machine will move (but don’t worry, this does not harm the 
machine). 

(Fan On and Fan Off are only for the cutter mkIII and controls the fans inside the 
controller box.   There is also a fan in the power box but it is always on). 

Plotter/cutter Plotter 
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Test Hardware 

 The xy-limit switches box should say on when you physically press either 
the x-limit switch at the back of the cutter over the channel rail or the y-limit 
switch at the back of the cutter head.   

 The z-limit switch relates to the limit switch inside the cutter head itself 
(remove the cover on the cutter head to see and press it).   

 Knife should say up when the head is up and down when you physically 
push the head down by hand.   

 (temperature is only displayed on the cutter mkIII and shows the temperature 
of the controller drives). 

 When finished, click OK to display the next dialogue which tests the signals 
coming from the plotter to the computer : 

Plotter/cutter Plotter 
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DXF Import 
DXF is a very popular file exchange format between CAD programs.  An example of a program 
that will save in the DXF format is AutoCad.  In fact most CAD programs can save/export in this 
format. 

To import a DXF file, select Open from the File menu and select “AutoCad (*.DXF)” for File of 
type : 

The file will be imported as one complete drawing. 

A non-plotting envelope is placed around the drawing so it behaves as one panel.  This 
envelope is only there to allow you to select the drawing with the mouse.  It is ignored 
by the plotter and by other panels which can be compacted against the drawing inside 
this envelope.  To identify that this panel has a non-plotting envelope around it, the 
panel will be coloured blue. 

You can nominate which lines are cut lines by ticking internal cut lines and specifying 
a colour or a layer.  Use the View Layers or View Colours button to see the 
layers/colours in the file. You can then select one by double clicking on it. 

If separate closed shapes is NOT ticked : 

DXF files are simply a collection of lines and text.   Each line and text also has a colour and a 
layer.  However the DXF format does not contain any information to identify panels.  Hence it is 
the job of the DXF Import software to try to determine which lines define a panel.  The 
following dialogue is where you tell the software how to do this. 

There are 2 ways to read DXF files depending upon whether separate closed shapes is ticked 
or not. 
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DXF Import 

Keep max Gap as small as possible.  Usually 0.1mm is enough.  If it is too large, lines 
that are closer than max Gap to the closed shaped (including other closed shapes) will 
become part of it. 

This example would cause 
problems if the gap at the 
top right is larger than max 
Gap. 

Closed shapes are shapes that you can entirely trace with your finger from a start point 
back to the same point (assuming any gaps in the outline are within the max Gap value 
specified in the dialogue) : 

(i)   Without lifting your finger (unless it is less than max Gap). 

(ii)  And without back-tracking over any part of the shape your finger has already been. 

(iii) And without crossing any part of the shape your finger has already been. 

 

Each of these closed shapes will become the outline of another panel. 

Closed shapes must not 
touch each other. They must 
be at least max. Gap away 
from each other.  This 
example would be seen as a 
single panel. 

If separate closed shapes is ticked (most common) 

  Any closed shapes in the DXF file will be made into separate panels. 
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DXF Import 

In the above example lines inside closed shapes (including any other closed shapes 
that completely fit inside) will become internal lines for that panel.  To allow for any 
internal lines that might slightly cross outside closed shapes, you can specify a clip 
seam allowance.  This is an imaginary seam around the outside of each closed shape.   
Any lines within this seam will be considered to be inside the closed shape. 

You can nominate which of these internal lines are cut lines by ticking internal cut 
lines and specifying a colour or a layer.   

Click view colours or view layers to see the colours/layers in the file.  (It is not 
necessary for the panel outline to be this colour/layer since the outline will always be 
cut). 

 

 

If any closed shapes comprise different coloured/layered lines, closed shapes can be 
multi-colour/layer will need to be ticked.  Otherwise it should not be ticked. 

If there are any lines left over that don't fit inside closed shapes (including clip seam 
allowance), they will be placed inside an extra panel (blue panel) with a non-plotting 
envelope around it. 

If some of the closed shapes cross over themselves, they will still be considered a 
panel but the panel will be coloured red. 

Hence if a blue panel or red panel(s) are generated you will know that there was a 
problem with some lines. 

Problems importing closed shapes 

If the importing software fails to recognise closed shapes : 

1) Make sure the distance between closed shapes is at least max. Gap. 

 2) If the distance between any internal lines and its closed shape is less than max. Gap, 
make the internal lines a different colour/layer from their closed shape and turn closed 
shapes can be multi-colour/layer off.  Of course the closed shape will need to be of 
one colour/layer. 

If it is not possible to change the above, reduce max. Gap.  The smallest value for max. 
Gap is 0 - but this requires the closed shapes to be perfectly closed without any gaps. 
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Units :  DXF files are usually saved either in inches or mm.   If you find after 
reading the DXF file it is too small or too large try changing Units. 

Version 1, version 2 :  This is the version of the Importing software.  Version 2 should 
normally be selected since it is the most advanced version.  However 
if there are some problems with version 2, you might try selecting 
the older version : version 1.  

include Text :  Click this if you want the text/numbers in the DXF to  be read.  
Sometimes DXF files contain a lot of extra text that you don’t want to 
read. 

use Text as panel name : Tick this if your DXF file has the name of the panel inside each 
panel. This will allow you to see the name of the panel on the nesting 
screen.  If however the panels have more text in them than just the 
panel name, this should not be ticked. 

max. smooth angle :  Often DXF files approximate curves as a series of straight line 
segments and are hence read by the importing software simply as 
straight line segments.  However if after reading these files you want 
to edit the shapes it is more useful if these straight line segments are 
identified as a curve.  If max. smooth angle is ticked the importing 
software will look at these lines and decide whether some of these 
should be part of a curve or remain as distinct line segments.  It does 
this by looking at the angle between adjacent lines : 

 

 

 

 

 If this angle is less than max. smooth angle it will assume these two 
lines are part of a curve.  Otherwise it will assume they are separate 
lines forming a corner.  The angle you specify will depend upon the 
CAD software you saved the file from.  Some CAD programs don’t 
save many points on their curves and hence you need to specify larger 
values for max. smooth angle.  However the larger the value, the 
more likely the importing software is to incorrectly interpret a corner 
as a smooth curve. 

DXF Import 
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DXF Import 

Set panel name = file name  : If multiple DXF files need to be added together (perhaps one 
panel per file), multiple files can be selected in the open file dialogue 
by holding down the Ctrl or Shift keys and clicking the desired files.   

 To select all files in the folder, first click on one and then press Ctrl-A. 

 If set panel name = file name is ticked, the panels in each file will 
be given the same name as the file it is read from.  This is useful if 
separate closed shapes is off and multiple files are opened at once. 
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HPGL Extended Import 

Although not as popular as DXF, HPGL is still a common format.   

Some CAD programs will not save/export in the HPGL format directly.   Rather you need to set 
up an HPGL printer (do this with Add Printer in the MS-Windows Control Panel) with output set 
as a file.  Hence when you tell your CAD program to print to this printer it will create an HPGL 
file on disk.   This is the method AutoCad uses. 

To import an HPGL file you need to first rename the extension of the file.  Initially the extension 
will probably be “.plt”.   This needs to be renamed to “.igl”. 

Then go to the nesting software and select Open from the File menu and select “HPGL (*.IGL)” 
for File of type : 

HPGL files are read in a very similar way as DXF files.  Hence please refer to the previous 
chapter regarding DXF Import. 

The differences are : 

1) There are no layers in HPGL files, only colours. 

2) Any unit scale can be used.  1016/inch is the most common.  If use saved units if 
available is ticked, the software will look to see if the hpgl file has the units specified in 
the file.  If it does it will use those.   Otherwise it will use the units you specify. 
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Export 

These optional export modules allow you to create files of a different format required by other 
CAD software. 

Plot Other : NTV 

 This format is used by PlotterPilot, Dimension Sailcloth and others. 

 

Plot Other : DXF 

 This is probably the most common CAD format.  Most CAD software will read 
this format. 

 

 

 

 

 

 

 X scale and Y scale are the scale used by the importing software.  A value of 
1 corresponds to inches.  25.4 will correspond to mm. 

 Tick AAMA if the importing software requires the AAMA format. 

 

Plot Other : Carlson 

 For use with a Carlson plotter. 

Plot Other 
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Nesting Menus 
File 
 New  : Create a new square or circular panel. 
 Open Ctrl O : Open an existing panel file. 
 Save Ctrl S : Save the changes made to the current panels. 
 Save As.  : Save the current panels with a new name. 
 …………… 
 Copy to.  : Save a copy to a different directory (usually to an external device 

like a memory stick or network). 
 …………… 
 Add Ctrl A : Add an existing panel file to the current panels. 
 …………… 
 Units  : Display the Units Preferences dialogue. 
 Preferences  : Display the general preferences dialogue. 
 ...............  
 Quit Ctrl Q : Leave PanelMaker. 
 
Edit 
 Shaping Ctrl F : Enter the Shaping Window. 
 ...............  
 Scale  : Scale the highlighted panel(s) up or down. 
 Divide  : Divide the highlighted panel(s). 
  
Nest 
 Group  : Group the highlighted panel(s) together. 
 Ungroup  : Ungroup the highlighted panel(s). 
 ...............  
 Colour  : Change the colour of the highlighted panel(s). 
 ...............  
 Reset Compact : Reset compaction memory. 
 ...............  
 Preferences  : Display the Nest preferences dialogue. 
 
Fabric 
 Plot Options Ctrl V : Displays the Plot Options dialogue. 
 Width Ctrl W : Width of fabric. 
 
Print 
 Offsets  : Print panel offsets for hand plotting. 
 ...............  
 Screen  : Print the window. 
 
Plot 
 Plot  : Start plotting. 
 ............... 
 Move To  : Move the plotter to a corner of the table. 
 ............... 
 Setup  : Calibrate and test dialogues for the Plotter. 
 ............... 
 Preferences  : Display plotting preferences dialogue. 
 
Digitise 
 Digitise  : Connects to the ProSail 2D digitising machine. 
 Triangulate  : Goes to the optional Triangulation module for manual digitising. 
 
About 
 About  : Display information about software version etc. 
 Bug Report  : Creates a problem report file that can be e-mailed to Armstrong-

White for problem support. 
 Check Preferences : Check all preferences for unusual settings. 


